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Welcome to PColP Software Client for macOS

Welcome to the Software Client for macOS Administrators' Guide.

PColP Software Clients are applications that establish PColP sessions with remote Windows,
Linux, or macOS desktops. Connections can be made to PColP agents installed on virtual or
physical machines, or to Remote Workstation Cards in physical workstations.

This guide explains how to install, configure, and use the Software Client for macQOS. It includes
client system requirements and information on host dependencies.

Who Should Read This Guide?

This guide is intended for administrators and users who install, configure, or use the Software
Client for macOS.

Additional Documentation

The following guides contain additional information relevant to PColP systems and PColP
Software Clients:

For more information about HP Anyware, including detailed information on included PColP
components as well as HP Anyware plans, see the Teradici Cloud Access Architecture Guide.

For more information about Teradici PColP agents, which are required on remote virtual machines,
see the following pages:

+ Teradici PColP Graphics Agent for Windows

« Teradici PColP Graphics Agent for Linux

« Teradici PColP Graphics Agent for macOS

+ Teradici PColP Standard Agent for Windows

+ Teradici PColP Standard Agent for Linux
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https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/22.09/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.09/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/macos/22.09/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/22.09/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/22.09/

Additional Documentation

For information about Teradici PColP Remote Workstation Card Software, which is required on
remote workstations using a Teradici PColP Remote Workstation Card, see the following pages:

« PColP Remote Workstation Card Software for Windows

« PColP Remote Workstation Card Software for Linux
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https://docs.teradici.com/find/product/remote-workstation-card/current/remote-workstation-card-software-for-windows
https://docs.teradici.com/find/product/remote-workstation-card/current/remote-workstation-card-software-for-linux

What's New in This Release

What's New in This Release

The PColP Software Client for macOS 22.09 introduces the following features and enhancements:

- Adds Wacom tablet USB support for macOS 11 (Big Sur) and 12 (Monterey)
- Removes support for macOS 10.15 (Catalina)

+ HP Anyware Client User Interface Refresh: This release introduces our newly-redesigned user
interface, with a clean, modern feel and greatly simplified connection management. For more
information, see Connecting to Remote Desktops.

As part of the interface update, the following settings are now available via the pre-session Ul
(previously, these were only available programmatically). See the following topics for more
information:

o PColP Log Level
o PColP Client Security Mode
o USB Auto-Forwarding

+ Collaboration Input Control: This release introduces input control for PColP Ultra
Collaboration sessions, allowing session hosts to yield mouse and keyboard control to their
guest collaborators. This feature is off by default and is enabled on the PColP Agent. For more
information, see the guide for the PColP agent you are connecting to:

o Graphics Agent for Windows

o

Graphics Agent for macOS

o

Graphics Agent for Linux

o

Standard Agent for Windows

o

Standard Agent for Linux

+ Introduces the next-generation High Performance Client mode [TECHNOLOGY PREVIEW].
The next-generation high performance client mode is now available as a technology preview
for testing and feedback. This new high-performance mode combines the audio and video
performance gains of the legacy high-performance client with the full functionality of the
standard client. See Next-Generation High Performance Client more information.

* Bug fixes and stability enhancements.
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https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/22.09/admin-guide/features/collaboration/collaboration/#collaborator-input-control
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/macos/22.09/admin-guide/features/collaboration/collaboration/#collaborator-input-control
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.09/admin-guide/features/collaboration/collaboration/#collaborator-input-control
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/22.09/admin-guide/features/collaboration/collaboration/#collaborator-input-control
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/22.09/admin-guide/features/collaboration/collaboration/#collaborator-input-control

System Requirements

System Requirements

The following table outlines the system requirements for the PColP Software Client for macOS:

System Version Required

PColP Software Client _
Operating Systems * macOS 11 (Big Sur)

+ macOS 12 (Monterey)

Compatible PColP Agents The Software Client for macOS can connect to any PColP agent. Some features
require specific agent versions; see the Feature Support section of this guide for
details.

We recommend always using the same version of PColP agent and PColP client.

Compatible PColP Remote TERA22x0 with firmware 20.04+ and PColP Remote Workstation Card Software for
Workstation Cards | ! Windows or Linux 20.04+.
Supported IP versions IPv4 and IPV6.

A Important: PColP Ultra is supported on Intel Macs only

PColP Ultra is not supported on Apple Silicon-based Macs.

Hardware System Requirements

For different display configurations Teradici recommends certain processor and RAM
combinations:

+ For up to dual 1920 x 1080 display configuration Teradici recommends 1.6 GHz dual core
processor or higher with at least 4 GB RAM.

+ For up to dual 4K/UHD Teradici recommends a 3.0 Ghz quad core processor or higher with at
least 8GB Dual Channel RAM.
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Hardware System Requirements

1. For details on feature limitations between PColP Software Clients and PColP Remote Workstation Cards, see
Connecting to PColP Remote Workstation Cards.
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Audio Support

Audio Support

Stereo audio output and mono audio input are supported and enabled by default.

The PColP Client provides an enhanced audio and video synchronization (AV Lock) feature that
provides improved full-screen video playback, reducing the difference in delays between the audio
and video channels and smoothing frame playback on the client. This improves lip sync and
reduces video frame drops for movie playback. This feature introduces a small lag in user
interaction responsiveness when enabled. Using enhanced audio and video synchronization will
reduce the maximum frame rate.

Audio input devices should not be bridged to the remote session. Audio input devices are locally
terminated and utilize local OS audio drivers. A bluetooth headset can be supported locally, but
cannot be bridged.

2" Note: Special configuration required for macOS 10.15 (Catalina)

Special configuration is required to enable microphone access on macOS 10.15. For instructions, see Microphone
Access on MacOS Catalina 10.75.

Multi-Channel Audio Output

The PColP Client supports multi-channel audio output when connecting to the macQOS PColP
Graphics Agent.

Requirements

+ A multi-channel audio device that supports 2.1, 5.1 or 7.1 channel configuration.
+ PColP Graphics Agent for macOS version 21.10 or newer.

+ PColP Client for macOS version 21.10 or newer.

+ PColP Standard Agent for Windows version 22.04 or newer.

+ PColP Graphics Agent for Windows version 22.04 or newer.
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Current Limitations

Current Limitations

+ Only 2.0,2.1, 5.1 and 7.1 channel configurations are currently supported.

Enabling Multi-Channel Audio Output

After you connect your audio device to your macOS PColP Client, follow the instructions outlined
below to ensure it is configured as the default audio device prior to establishing your PColP
session:

1. From the macOS System Preferences click Sound.

® 0 < i3 Sound Q

Sound Effects  Output  Input

Select a device for sound output:

Name Type
Mac mini Speakers Built-in
Sound Blaster X3 SPDIF Out uUsSB
Sound Blaster X3 Speakers USB
BlackHole 8ch Virtual

Settings for the selected device:

The selected device has no output controls

Output volume: of L D) Mute

Show volume in menu bar

2. Click on the Output tab.
3. Select the audio device you wish to make your default device.

4. Close System Preferences.
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Enabling Multi-Channel Audio Output

Once you have set the default audio device you can connect to your PColP Agent for macOS.
During session negotiation the PColP Agent will configure PColP Virtual Speakers, with the same
number of channels as your PColP Clients default audio device.
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Client Modes

Client Modes

The Software Client for macOS supports the following operational modes:

Standard Client Mode

This mode is the default, and is recommended for most environments. The standard mode
provides a good balance of performance features, and has the full complement of in-session
menu features.

If you require high framerate support or need PColP Ultra AV Lock, you can switch to the High
Performance Client mode, described next.

/" Note: Standard mode does not support PColP Ultra AV Lock

PColP Ultra AV Lock is supported by the High Performance Client and the Next-Generation High Performance Client
Mode. It is not available in the standard client mode.

6 Tip: Next-generation High Performance Client Preview

The next-generation High Performance Client mode is now available for testing and feedback. See Next-Generation
High Performance Client Mode for details.

High Performance Client Mode

High performance client mode is a special mode which provides higher frame rates, with fewer
dropped frames, than the default client, and supports PColP Ultra AV Lock. This mode is especially
beneficial for 4K video workloads.

The High Performance Client has limited in-session client feature support. The High Performance
Client does not support the full suite of in-session menu features available on the standard client.
For this reason, we recommend the high performance client only for scenarios which require high
frame rates and reduced dropped frames, or where support for PColP Ultra AV Lock is required.
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High Performance Client Limitations

/" Note: Auto-forwarding by device ID is supported

The high performance client supports auto-forwarding USB devices, such as Wacom tablets, by providing their device
IDs in a configuration call; see Vidpid Auto-Forward for details.

High Performance Client Limitations
The high performance client has the following major limitations:

+ Only Fullscreen all monitors display mode is supported.
+ The following limited in-session menu options are available:
o Teradici PColP Client menu
+ Quit Teradici PColP Client
o Connection menu
+ Send (Ctrl + Alt + Del
- Disconnect (To disconnect use ‘ctrl + alt + ~ )
> View menu
- Minimize Client (You can minimize the client by using (ctrl + alt +m)
+ Tablet Monitor
+ Tablet Orientation Left-handed

- PColP Ultra AVLock

To Enable High Performance Client (Legacy) mode:

1

2. In the Software Client for macOS, click the gear icon to open the client settings window.

Tooo

. If you are in a PColP session, disconnect from it.

w

. In the side navigation panel, click Advanced.

N

. Inthe advanced settings, find the Client Mode section, and select High Performance (Legacy).

ol

. Close the settings window.
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Statistics Overlay

Subsequent PColP sessions will use the preview version of the High Performance Mode.
To Disable High Performance Client (Legacy) mode:

1. If you are in a PColP session, disconnect from it.
In the Software Client for macOS, click the gear icon to open the client settings window.

In the side navigation panel, click Advanced.

> W™

In the advanced settings, find Client Mode, and select Standard Mode or High Performance
(Preview).

5. Close the settings window.

Subsequent PColP sessions will use the mode selected.

6 Tip: Next-generation High Performance Client Preview

The next-generation High Performance Client mode is now available for testing and feedback. See Next-Generation
High Performance Client Mode for details.

Statistics Overlay

The statistics overlay is an additional feature provided by the High Performance Client, which
displays performance and configuration data for your connection.

Codec: PColP Ultra GPU
Chroma: YUV 4:2:0
HW Decode: Yes

FPS: 15.0
Dropped Frames: 1.69% (1/59)

The overlay shows the following information:

© 2021 Teradici
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Next-Generation High Performance Client Mode

Value Description

Codec Reports the current PColP encoding that is in use. Possible values are PColP Ultra CPU, PColP Ultra
GPU and PColP.
Encoding Reports the color space that is being used to encode the information. PColP and PColP Ultra CPU

offload will report RGB 8:8:8 which means full 8 bit RGB pixels are being used. For PColP Ultra GPU
optimization, either YUV 4:4:4 or YUV 4:2:0 will be used, depending on the system configuration.

HW Reports whether or not the PColP Client is decoding the frames using built-in GPU hardware
Decode decoding.
FPS Reports the current frames per second that are presented on the PColP Client.

To enable the statistics overlay:

1. Open the Software Client for macOS configuration file in a text editor. For instructions and file
locations, see Configuration Files.

2. Add the following line:
enable_high_perf_client_stats_overlay=1

3. Save thefile.
To toggle the statistics overlay:

1. If you are in a full-screen mode, reveal the Software Client for macOS menu bar by moving the
mouse cursor to the top of a display.

2. From the High Performance Client menu bar, select View > Statistics Overlay.

Next-Generation High Performance Client Mode

The next-generation High Performance Client is now available as a technology preview. This new
high performance client combines the best of the current Standard and High Performance Client
modes, providing all of the features available to the standard PColP client while delivering
improved video and PColP Ultra AV Lock features.

© 2021 Teradici
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Next-Generation High Performance Client Mode

In a future release, this mode will replace both the standard and High Performance Client (legacy)
modes.

A\ Caution: Preview feature

This release of the next-generation High Performance Client may have stability or performance issues in certain
situations. We recommend using either the standard mode or legacy high performance mode for production work.

To Enable High Performance Client Preview:

1. If you are in a PColP session, disconnect from it.

2. In the Software Client for macQS, click the gear icon to open the client settings window.

2 0O 0O

3. In the side navigation panel, click Advanced.

4. In the advanced settings, find the Client Mode section, and select High Performance
(Preview).

© 2021 Teradici
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Next-Generation High Performance Client Mode

USB Devices (@) Security mode - Medium

If a certificate cannot be verified you will receive a warning, but you will
Logs still be able to connect. This is the default security mode.

Security mode - Low

Advanced You do not need to verify the certificate to connect.

Client Mode

It is possible to enable different performance modes for the HP Anyware
client depending on your use case.

(O Standard client
Recommended for the majority of use cases. Preferred by users
requiring the most consistent experience at moderate framerates.

High Performance (Preview)
Recommended for high framerate and audio synchronization. Preview

of the next generation client mode that is designed to replace both
legacy modes for all users. This is still being refined for performance
and consistency.

(O High performance client
Only recommended for users with high performance audio
synchronization requirements, is missing R2atures offered in the other
modes. This mode will be deprecated in future releases, replaced by
the next generation High Performance Client currently in preview.

5. Close the settings window.
Subsequent PColP sessions will use the preview version of the High Performance Mode.
To Disable High Performance Client Preview mode:

1. If you are in a PColP session, disconnect from it.
2. In the Software Client for macQS, click the gear icon to open the client settings window.
3. Inthe side navigation panel, click Advanced.

4. In the advanced settings, find Client Mode, and select Standard Mode or High Performance
(Legacy).

5. Close the settings window.

Subsequent PColP sessions will use the mode selected.

© 2021 Teradici
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Collaboration

Collaboration

The PColP Ultra Collaboration feature enables a user to share their PColP session with a remote
guest collaborator using a PColP Software Client. While connected, the guest collaborator can
view the screen output and hear the audio output of the shared PColP session.

When discussing this feature, we'll refer to the first user as the host collaborator, and the second
user who joins the session as the guest collaborator.

/" Feature Support, Requirements and Limitations

+ The PColP Ultra Collaboration feature is supported when connecting from any PColP software client to any PColP
agent.

+ When connecting to a PColP standard agent, PColP Ultra CPU Offload is required.

+ When connecting to a PColP graphics agent 22.07 or later, PColP Ultra CPU Offload, GPU Offload, and Auto
Offload are supported.

+ Collaboration Mouse Visibility only works when the host collaborator and all guest collaborators are using a
PColP Client in Standard Client mode, or in the next-generation high performance client mode (technical preview).
The high performance client mode does not support mouse visiblity.

The features described on this page are only supported when both PColP Clients and PColP Agents are running on
version 22.07 or later.

Enabling and Hosting a Collaboration Session

For information and steps on how to enable collaboration, and how to host a collaboration
session, see the PColP Agent documentation linked below. The instructions for enabling and
hosting collaboration will vary based on the PColP Agent you use. You should select the
instructions that apply to the PColP Agent that you are connecting to:

+ PColP Graphics Agent for Linux -Collaboration

+ PColP Graphics Agent for macOS - Collaboration

+ PColP Graphics Agent for Windows - Collaboration

+ PColP Standard Agent for Linux - Collaboration
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https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.09/admin-guide/features/collaboration/collaboration/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/macos/22.09/admin-guide/features/collaboration/collaboration/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/22.09/admin-guide/features/collaboration/collaboration/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/22.09/admin-guide/features/collaboration/collaboration/

Joining a Collaboration Session

+ PColP Standard Agent for Windows - Collaboration

6 Important: User input control

PColP Collaboration sessions support user input control, which allows the session host to transfer control of
keyboard and mouse input to the guest collaborator. This feature is disabled by default. Instructions for enabling input
control, and guidance on usage, are also available in the PColP agent documents linked above.

Joining a Collaboration Session

The guest collaborator can join the PColP session once they have received the invite link and invite
code from the host collaborator. Invite links and codes are generated on the remote PColP agent
machine; for instructions, refer to the agent administrators' guides linked above.

1. Open a web browser and go to the invite link shared with you (you may be able to click this link
directly, depending on how it was shared with you).

2. The web browser will warn you that the link is attempting to open the PColP Client application.
Allow the browser to open the PColP Client.

3. When the PColP Client opens, it will prompt you for your name and the Collaboration Invitation
Code. The value you enter for your name is used to tell the host who is joining; the
Collaboration Invitation Code is the six digit number provided by the host. Enter both values
and click Submit.

4. Once the host collaborator accepts your connection request, the Collaboration screen share
will start.

5. To leave the collaboration session, select Connection > Disconnect from the PColP Client
menu.

Mouse Visibility

Collaboration Mouse Visibility allows the guest collaborator to see the host's mouse cursor
movements within a collaboration session. This feature is only available when both collaborators
are using a PColP client 22.07 or newer, and the PColP agent is also version 22.07 or later.

© 2021 Teradici
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https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/22.09/admin-guide/features/collaboration/collaboration/

Mouse Visibility

Currently, mouse visibility only works in the default standard client mode. High performance client
mode does not support mouse visibility. See High Performance Client for instructions to enable or
disable high performance client mode.

Future releases will add the ability for the Guest Collaborator to take control of the session mouse
and keyboard.

© 2021 Teradici
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Display Modes

Display Modes

The PColP Client supports a maximum of four displays and a maximum resolution of 4K UHD
(3840x2160).

Monitors can be arranged in a vertical line, a horizontal line, or as a 2x2 box display. They can be
used in any standard rotation (0°, 90°, 180°, or 270°), with any monitor as the primary display.

/" Note: Using multiple high-resolution displays

Systems with multiple high-resolution displays, such as quad 4K UHD topologies, require powerful system
infrastructure. Be sure to use a system with sufficient bandwidth and client capability to support your required display
topology.

6 Important: Attaching monitors to the host machine in not supported

PColP client supports a maximum of four displays. Attaching extra monitors to the host machine will conflict with
client display topologies.

Using Full-Screen Modes

FullScreen modes extend macOS Mission Control functionality. To work as intended, the client
machine should have Displays have separate Spaces enabled in Mission Control settings. For

more information, see

© 2021 Teradici
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Language Support

Language Support

The Software Client for macOS is not currently localized, and is offered only in English.
Localization will be added in a future release.

If you require language support in non-English languages, we recommend using the Software
Client for macQOS 22.07, which is localized.

© 2021 Teradici
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PColP Ultra

PColP Ultra

The Software Client for macOS provides support for PColP Ultra, the latest protocol
enhancements from Teradici.

PColP Ultra enhancements are controlled on the PColP agent. There is no configuration required
on the PColP Client.

; Important: PColP Ultra is appropriate for specific use cases
For most users, the default PColP protocol will provide the best possible experience. Carefully review the
recommended use cases in the next section to determine whether you should enable it.

/" Requirement: AVX2 Support

On Windows or Linux machines, both the client and agent CPUs must support the AVX2 instruction set. This
requirement does not apply to macOS machines.

For additional detail on PColP Ultra technical requirements for various use cases and
troubleshooting steps, refer to KB 2109: PColP Ultra Troubleshooting.

PColP Ultra Modes

PColP Ultra has three acceleration modes, which leverage CPU and GPU offloading to optimize

content delivery.

+ Auto Offload: Dynamically switches between CPU and GPU offload modes depending on the
workload being processed. This setting is appropriate for work-from-home or WAN content
creators who require optimized delivery of high resolution content, including video playback,
while still achieving build-to-lossless color accuracy. This mode requires a GPU and a graphics
agent.

-+ CPU Offload: Provides efficient scaling across multicore CPUs, leveraging AVX2 instruction
sets. Appropriate for users that require CPU-optimized delivery of 4K UHD, high-framerate

© 2021 Teradici
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https://help.teradici.com/s/article/2109

Enabling PColP Ultra

video playback and build-to-lossless color accuracy. It is also useful when GPU encoding
resources must be reserved for video encoding applications, typically in LAN environments.

+ GPU Offload: PColP encoding is always offloaded to a GPU. Appropriate for users who
demand the highest possible CPU efficiency. This mode requires a GPU and a graphics agent.

Enabling PColP Ultra

PColP Ultra is disabled by default, and must be enabled on the PColP agent. The method used to
do this varies by agent type; consult the following documentation for instructions:

+ PColP Graphics Agent for Windows

+ PColP Graphics Agent for macOS

+ PColP Graphics Agent for Linux

+ PColP Standard Agent for Windows

+ PColP Standard Agent for Linux

Auto-Offload with PColP Ultra

When using a PColP graphics agent, PColP Ultra can automatically select and switch between
CPU-offload and GPU-offload modes based on the amount of pixel change in the displays. When
displays are rendering highly dynamic content, PColP Ultra will enable GPU Offload to provide
improved frame rates and bandwidth optimization. When displays are less dynamic, PColP Ultra
defaults to CPU offload to provide the best image fidelity.

PColP Ultra Offload only takes effect if the remote PColP graphics agent and the PColP software
client are capable of both CPU and GPU offload.

The PColP Ultra offload mode is set on the PColP agent; PColP Ultra Auto Offload requires a PColP
Graphics Agent. Refer to the appropriate documentation for instructions:

+ PColP Graphics Agent for Windows
+ PColP Graphics Agent for macOS

+ PColP Graphics Agent for Linux

© 2021 Teradici

21


https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/22.09/admin-guide/features/pcoip/ultra/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/macos/22.09/admin-guide/features/pcoip/ultra/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.09/admin-guide/features/pcoip/ultra/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/22.09/admin-guide/features/pcoip/ultra/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/22.09/admin-guide/features/pcoip/ultra/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/22.09/admin-guide/configuring/configuring/#pcoip-ultra
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/macos/22.09/admin-guide/configuring/configuring/#pcoip-ultra
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.09/admin-guide/configuring/configuring/#pcoip-ultra

PColP Codec Indicator

PColP Codec Indicator

When enabling PColP Ultra there will be an onscreen indicator at the bottom left corner of the
screen. PColP Ultra CPU optimization is indicated with a dark blue dot. PColP Ultra GPU
optimization is indicated by a magenta dot.

To disable this codec update the pcoip.code_indicator parameter:
~/.pcoip.rc pcoip.codec_indicator = 0

Ensure that you maintain the space before and after the = sign.
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Printing Support

Printing Support

The following are the printing options available with the PColP Client:

+ Local USB Printing: Printing to a USB printer locally attached to the Client device.

- Remote Network Printing: Enables printing to a network printer on the nost machines
network. Not suitable in situations here the PColP Software Client device is not on the same

network as he host device.

+ Cloud Printing: This is access to external Cloud Services that are set-up on your local
workstation and network. Once these services have been correctly configured they can be
used by the PColP Software Client.

+ Local Network Printing: Enables printing from the host machine to a printer in the PColP
Client machine's local area network. This method is suitable for printing when host and client
are not on the same network or for identifying and printing to local printers that exist in multi-
Site organizations.

Support for each of these methods varies depending on which PColP agent the Software Client for
macOS connects to. The Software Client for macOS printing support is as follows:

Windows agents Linux agents macOS agents
Local USB Printing - - -
Remote Network Printing v - -
Local Network Printing v - -

Cloud Printing v - -
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Relative Mouse Support

Relative Mouse Support

Relative Mouse is a method of translating mouse movements as a delta from the last mouse
position rather than a move to an absolute position on the screen. This type of mouse control is
used in many CAD/CAM, Visual Effects and First-Person Gaming software. In a CAD program you
may want to control an objects orientation in 3-D with mouse movements. Moving the mouse to
the left or right rotates the object around the Z-axis, and moving the mouse up or down rotates the
object around the X-axis. As you continue to move the mouse left the object continues to rotate
about the axis, and the rotation is not bounded by the mouse stopping at the boarders of the

screen.

While in relative mouse mode, the mouse cursor is not visible since it the mouse is controlling
directional movement and is not pointing to a location on the screen.

Applications that use relative mouse movements generally provide methods for entering or exiting
relative mouse mode, for instance clicking on an object with the middle button. While the middle
button is held down the object may be controlled using relative mouse movements.

Relative mouse mode is supported by all PColP clients. Note that PColP Zero Clients must be
configured to enable it.

Relative mouse mode is supported by the following agents:

+ PColP Standard Agent for Windows
+ PColP Graphics Agent for Windows
+ PColP Standard Agent for Linux

+ PColP Graphics Agent for Linux

Relative mouse mode is not supported by the PColP Graphics Agent for macOS.

/" Note: Only supported on standard mode

Relative Mouse is not supported when a client is running in High Performance Mode. It is only supported in standard
mode.
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Enabling Relative Mouse

Enabling Relative Mouse

The following sections outline how to enable relative mouse support on the Software Client for

macOS.

Enabling from the Menu Tab

The following steps outline how to enable relative mouse from the menu tab, while connected to a
supported PColP Agent with a supported PColP Client:

1. Click Connection from the menu tab.

2. Select the Relative Mouse option and click it to enable it. Once the check-mark is visible
beside the Relative Mouse option it is enabled.

If you are connected to a PColP Agent version that does not support relative mouse then you will
not be able to select this option.

Enabling with a Hot-Key

To enable relative mouse using a hot-key, while connected to a supported PColP Agent with a
supported PColP Client, press ctrl + alt + r . This will toggle the feature on and off. This will
only work if you are connected to a PColP Agent version that supports relative mouse.
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USB Support

USB Support

PColP Clients supports redirecting USB devices to a remote session. Administrators can set rules
governing allowed and disallowed devices, device classes, or device protocols.

6 Important: USB support is enabled by default

USB bridging is enabled by default. If you want to restrict or disable USB support, you can globally disable or set rules
governing USB behavior via GPO settings on the PColP Agent.

6 USB Redirection

USB redirection is only intended to be used with a single instance of the PColP Software Client. Launching a second
instance of the PColP Software Client while USB devices are redirected from another client may not work as expected.

Remote USB Device Support

When remoting pointer-style USB devices such as a mouse, stylus, or Wacom tablet, you must
grant PColPClient.app computer control. You can enable this through the Preferences>Security &
Privacy>Privacy>Accessibility in system settings.

Isochronous USB device Support

The Software Client for macOS does not support isochronous USB devices.

USB Device Pressure Sensitivity

The Software Client for macOS may encounter issues with Wacom pressure sensitivity. This is as
a USB handling restriction on macQS Catalina. It occurs when you want to load the USB Kernel
Extension at session start up. For information on how to address this issue, see here.
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Wacom Tablet Support

Wacom Tablet Support

The Software Client for macOS supports Wacom tablets in two configurations: bridged, where
peripheral data is sent to the desktop for processing, and locally terminated, where peripheral data
is processed locally at the Software Client.

Locally-Terminated Wacom Tablets

Locally terminated Wacom tablets are much more responsive, and tolerate high-latency
connections better than bridged.

Local Termination is automatically used whenever it is supported for a device. If you prefer to use
bridged mode—if, for example, you must use sophisticated tablet features like touch, which is not
supported by local termination—you can override this behavior by blacklisting a device for local
termination.

Local termination requires a supported PColP agent (any type), and a supported Software Client
for macOS.

PColP client support for locally terminated Wacom tablets and the Software Client for macOS

PColP agents PColP PColP Graphics PColP Remote
(Windows) agents Agent for macOS Workstation Card
= (Linux) [ E
)

Intuos Pro Small v v — -

PTH-460

Intuos Pro Medium v v v -

PTH-660

Intuos Pro Large v v v -

PTH-860

Cintiq 22HD - - - -

DTK-2200
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Bridged Wacom Tablets

PColP agents PColP PColP Graphics PColP Remote
(Windows) agents Agent for macOS Workstation Card
= (Linux) (¢ |
)

Cintig 22 v v - -

DTK-2260

Cintiq Pro 24 - - - -

DTK-2420

Cintiq 22HDT - - - - -

Pen & Touch

DTH-2200

Cintiq Pro 24 - v v - -

Pen & Touch

DTH-2420

Cintiq Pro 27 v v - -

DTH-271

Cintiq 32 Pro - v v — -

Pen & Touch

DTH-3220

Bridged Wacom Tablets

Bridged Wacom tablets should be used only in low-latency environments. Tablets that are bridged
in network environments with high latency (greater than 25ms) will appear sluggish and difficult to
use for artists, and are not recommended.

When connecting a Wacom tablet, bridged mode is used only if local termination is not available.
To override this behavior, causing the Software Client for macOS to use bridged mode instead, add
the device to the Local Termination Blacklist.

2" Note: Graphics Agent for macOS does not support bridged Wacom tablets

The Graphics Agent for macOS only supports local termination of Wacom devices.
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Bridged Wacom Tablets

The following Wacom tablet models have been tested and are supported on the Software Client
for macOS:

PColP client support for bridged Wacom tablets and the Software Client for macOS

PColP agents PColP PColP Graphics PColP Remote
(Windows) agents Agent for macOS Workstation Card
= (Linux) (¢ E
14
Intuos Pro Small v v — v
PTH-460
Intuos Pro Medium v v — v
PTH-660
Intuos Pro Large v v - v
PTH-860
Cintiq 22HD v v - v
DTK-2200
Cintig 22 v v - v
DTK-2260
Cintiq Pro 24 v v - v
DTK-2420
Cintiq 22HDT - v v — v
Pen & Touch Ubuntu only
DTH-2200
Cintiq Pro 24 - v v — v
Pen & Touch
DTH-2420
Cintig Pro 27 v v - -
DTH-271
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Connecting Cintiqg Pro 32 Tablets

PColP agents PColP PColP Graphics PColP Remote
(Windows) agents Agent for macOS Workstation Card
= (Linux) ¢ E
14
Cintig 32 Pro - v v - v
Pen & Touch
DTH-3220

Connecting Cintig Pro 32 Tablets

The Wacom Cintiq Pro 32 appears as three separate devices in the USB menu. You should
connect the following USB devices to use this tablet:

+ ExpressKey Remote

+ Cintig Pro 32 Touch

+ Wacom Cintig Pro 32

[4 USB Devices X
a
DEVICES —
ExpressKey Remote Disconnect |
Cintig Pro 32 Touch Disconnect |
Wacom Cintig Pro 32 Disconnect I
USB3 Reader Connect |
Single RS232-HS Connect | |
USB Advanced Audio Device Connect | _I
v
[¥ Show Human Interface Devices. Devices that are auto-forwarded are not affected by this checkbox.
Close
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Known Issues

Known Issues
The following limitations apply to Wacom tablet support:
- Touch only works on the Cintig Pro 32 Pen & Touch (DTH-2420). Touch functionality is not

supported for any other Wacom tablet.

- ExpresskKey Remote does not work on the Wacom Cintig Pro 32 (DTH-3220). You should still
connect this device when connecting the Wacom tablet.

- There are cursor limitations when working with the Wacom Cintiq 22HD (DTK-2200) and
Wacom Cintiq Pro 24 (DTK-2420) for both bridged and locally terminated devices.

- Control buttons on the Wacom Cintiq Pro 32 (DTH-3220) do not function when locally
terminated.

+ PColP Clients are not compatible with NoMachine and No Machine USB drivers. For
information on how to uninstall NoMachine USB drivers, see No Machine's knowledge base.

6 Important: Wacom devices must be connected to the session for full feature support

Locally-terminated Wacom tablets must be connected to the PColP session using the Software Client for macOS's in-
session menu in order to use pressure sensitivity and other supported features. If a device is plugged into a USB port
but is not connected to the session, it will behave as a simple pointer device; this creates a confusing situation where
the device initially appears to work, but expected features do not function.
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Installing the PColP Software Client for macOS

Installing the PColP Software Client for macOS

In this section, you'll learn how to install and uninstall the PColP Software Client for macOS.

Before You Begin

Before installing a PColP Software Client:

+ You must be logged in as an administrator to the client machine.

+ Close any existing PColP Software Client applications.

Installing the PColP Software Client
To install the PColP Software Client:

1. Copy the PColP Software Client disk image file PColPClient.dmg to your desktop.
2. Double-click the file to mount the volume.
3. Accept the license agreement by clicking Agree.

4. In the PColPClient volume window, drag the PColPClient icon into the Applications folder icon
to install the program.

Alt Text
5. To optionally create an alias on the desktop or the dock:
+ Double-click the Applications folder icon to open the folder.
+ Drag the client application to the desktop or dock.

6. To egject the volume when you are finished, drag it to the trash.

To uninstall the PColP Software Client:

- Navigate to the Applications folder and drag the PColPClient program to the trash. Or, right-
click the application and select Move to Trash.
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Updating the Software Client

2" Troubleshooting PColP Session Connection Issues

If you encounter issues with your PColP Session, please see the following KB article: https://help.teradici.com/s/
article/1027. This article details some potential causes and fixes for common connection issues.

Updating the Software Client

To upgrade to a newer version of the Software Client for macOS, download and install the new
version in place. You do not need to uninstall your current version; your settings will be preserved.

Installing the Software Client in Silent Mode

The following section outlines how to install the PColP Software Client in silent mode. Please note
that you must authorize the application to run in silent mode. To install the PColP Software Client

on macQS in silent, run the following commands:

1. Attach the .dmg file:
yes | hdiutil attach <pcoip client installer>.dmg
2. Delete the current PColP Client:
rm -R '/Applications/PCoIPClient.app'’
3. Install the new PColP Client:
cp -R '/Volumes/<pcoip client installer>/PCoIPClient.app' /Applications
4. Unmount the drive afterwards:

yes | hdiutil unmount <pcoip client installer>
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Connecting to Remote Desktops

Connecting to Remote Desktops

ﬂ Important: Welcome to our new user interface!

In release 22.09, the Software Client for macOS user interface has been redesigned from the ground up. If you're a
new user, you should find the new interface easy to follow; for existing users, note that some behavior has changed.
Notes appear throughout this page when a task has changed from previous releases.

The Software Client for macOS can connect to any remote host with a PColP agent installed and
configured, or a PColP Remote Workstation Card. Remote hosts can be Windows, macOS, or
Linux, and can be made directly (client to host) or through a connection manager in enterprise
deployments.

/" Note: PColP Remote Workstation Card connections

Connections to PColP Remote Workstation Cards require preparation on the remote machine before they will work.
For details, see Preparing for PColP Remote Workstation Card Connections.

Creating Your First Connection

The first step is to create a connection to either your agent (for direct connections) or to your
connection manager (for managed deployments).

1. Launch the Software Client for macOS.

2. If this is your first connection, the Software Client for macOS will prompt you to create one:
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Creating Your First Connection

®
No Saved Connections

You can add a new connection, or contact IT to
have a connection provisioned for you.

Add a new connection

Click Add a new connection to proceed.

3. Inthe Add New Connection pane, there are two fields to provide:
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Creating Your First Connection

Add N ew Con neCtlon Host Address or Registration Code
|

Let's get started! Enter the host
address or registration code
provided by your system
administrator.

Connection Name

- Host Address or Registration Code: Enter the address of the remote system you want to
reach (you should have this information from your system administrator). This field
accepts IP addresses, domain names, and registration codes, as in these examples:

o An IP address: 123.456.789.012
o A domain name: remote-desktops.example.com

o A registration code: a1b2c3!@#

/" Note: Amazon WorkSpaces registration codes

If you are connecting to an Amazon WorkSpaces desktop, provide your WorkSpaces registration code
in this field.

+ Connection Name: Provide a name for this connection. This can be anything; you will use
this name to select this connection in future sessions. You can always change it later.

4. Click Add connection.
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Connecting to a Session

Once this is done, you'll see the connection you created shown as a clickable button. You can add

as many connections as you like, by clicking + Add a new connection at the bottom of the Connect
pane.

6 Tip: Difference from previous workflows

The connections you save here are to brokers, or to direct desktop connections. If you have multiple desktops behind
a single broker, you will still have to choose your desired desktop after authenticating with the broker. In the previous
interface, you could save connections at any stage of the process, including to individual desktops.

If you have existing saved connections from previous releases, they will continue to work when you upgrade to this
client version. However, if they are deleted, they cannot be re-created.

Connecting to a Session

1. Assuming you have created at least one connection, the Software Client for macOS will now
look something like this:

Connect Example desktop 1

Select a connection
Example desktop 2

Example desktop 3

+ Add a new connection

2. Click the name of the connection you want. Next, provide your username and password:
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Connecting to a Session

e O O
ConneCt Username
Password
Example desktop 1

« Back to connections

2" Note: About authentication credentials

For managed connections, the authentication screen and validation that happens here is managed by your
connection broker. The credentials are supplied to you by your system administrators, and are usually your

corporate credentials.
For direct connections where no broker is present, use the credentials for your user account on the remote

machine.

3. If your system is configured for multi-factor authentication, you will see a Multi-Factor
Authentication screen next; either provide your passcode if you have one, or click Send Me a
Push to have an authentication request sent to your registered device.
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Connecting to a Session

MUItI-FaCtor Passcode
Authentication sscode

Example desktop 1
or

Send Me a Push

« Back to connections

4. Once your credentials are accepted, the Software Client for macOS shows you a list of your
authorized desktops.

6 Tip: Customizing desktop labels

You can change the labels that appear in this list to make them easier to identify. See Changing the Remote
Desktop labels for instructions.
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Changing Remote Desktop Labels

Select Desktop

Example desktop 1

« Back to connections

Click the desktop you want to connect to.

Once you have selected your desktop, you will be connected to it and your PColP session will
begin. The connection will use the display mode you last used (windowed, fullscreen one monitor,
or fullscreen all monitors), unless altered by a launch-time configuration.

There may be a delay of a few seconds before you have control of your mouse and keyboard; this
is normal.

Changing Remote Desktop Labels

By default, the Software Client for macOS displays the machine names of your remote desktops.
These names can often be obscure strings that are difficult to identify or differentiate. You can
modify the name shown in the desktop list to give them human-friendly names that are easier to
understand.
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Changing Remote Desktop Labels

/" Note: Only labels are changed

This procedure changes the desktop's label, shown in the client interface. It does not change the desktop's machine
name.

To change the label for a desktop:

1. Select a connection in the Software Client for macOS and provide your credentials.

2. From the list of displayed desktops, find one you want to change and click its expansion icon
to reveal the context menu:

desktopMachineName1 [POWERED_ON]

desktopMachineName2 [POWERED_ON] :

C Restart Desktop

3. Click Rename.
4. Provide the new, human-friendly name you'd like to see instead of the machine name.

5. When finished, your desktops will appear using the name you specified:

Friendly name 1 [POWERED_ON]

Friendly name 2 [POWERED_ON]
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Restarting Remote Desktops

Restarting Remote Desktops

If your deployment supports remote restarts, you can command a desktop to restart from the
Software Client for macOS pre-session interface (before you have connected to a PColP session).

/" Note: Not all deployments support this feature

The restart option will only be available if your system supports it. If it does not, the restart option will appear in the
menu but will be disabled.

To restart a remote desktop:

1. Select a connection in the Software Client for macOS and provide your credentials.

2. From the list of displayed desktops, find one you want to restart and click its expansion icon to
reveal the context menu:

My MacOS Desktop

My Windows Desktop :

Other MacO¢< /# Rename

C Restart Desktop

3. Click Restart.

The remote desktop will be restarted. Note that it will be unavailable for connections until the
restart is complete, which may take several minutes depending on the system.
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Connecting to PColP Remote Workstation Cards

Connecting to PColP Remote Workstation Cards

You can connect to remote workstations equipped with a PColP Remote Workstation Card, and
with PColP Remote Workstation Card Software (for Windows or Linux) installed.

Refer to System Requirements for supported versions.

Initial Workstation Configuration

Before you can connect to your remote workstation for the first time, you must install software

and make some configuration changes. These actions only need to be taken once for each remote

workstation in your system:

+ Record the MAC address of the PColP Remote Workstation Card

Before you install the PColP Remote Workstation Card, record the MAC address of the PColP
Remote Workstation Card; this will allow you to log into the card to configure its settings. Type
https://pcoip-host-<MAC_ADDRESS>.mydomain where <MAC_ADDRESS> isthe MAC address
of your PColP Remote Workstation Card and mydomain is the local domain of your network.
This step is important as the host driver function is disabled by default, so the Remote
Workstation Card Software will not pick up information about the PColP Remote Workstation
Card, such as the MAC address. The MAC address enables you to connect to the PColP
Remote Workstation Card to view the IP address and enable the host driver function.

For more information on IP and MAC information relating to the PColP Remote Workstation
Card, see How do | find the IP address of my newly installed PColP Zero Client or PColP
Remote Workstation card? in the knowledge base.

+ Install the PColP Remote Workstation Card Agent: To connect to a PColP Remote
Workstation Card machine with a PColP Software Client, the Remote Workstation Card Agent
software must be installed.

- Verify accessibility: Both the NIC of the workstation and the NIC of the PColP Remote
Workstation card need to be accessible by the PColP Software Client. They can be on different
local networks as long as both are accessible by the PColP Software Client. If they are both
behind a NAT and accessed by the PColP Software Client then the PColP Remote Workstation
Card Agent must send the NAT'ed address to the PColP Software Client when connecting.
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Connecting to a PColP Remote Workstation Card through the command line

- Enable monitor emulation for the video ports on your remote workstation: If monitor
emulation is not enabled, you may see blank gray screens when you connect from the PColP
Software Client.

To enable monitor emulation, log in to the card’'s Administrator Web Interface (AWI) and select
Enable Monitor Emulation on Video Port n from the Configuration > Monitor Emulation menu.
For more information, see the PColP Remote Workstation Card Administrators’ Guide.

- Disable temporal dithering: Temporal dithering causes blurriness, heavy packet loss, and high
CPU usage on the PColP Software Client machine.

- Linux workstations: configure PColP Remote Workstation Card Software to Start
Automatically: To configure the PColP Remote Workstation Card Software to start
automatically, log into the workstation using a PColP Zero Client or directly from a local
mouse and keyboard, and modify the workstation startup script to launch the PColP Remote
Workstation Card Software. For details, see Installing PColP Remote Workstation Card
Software Binary RPM in the PColP® Remote Workstation Card Software for Linux User Guide.

Once the remote workstation is properly configured, you can use the Software Client for macOS to
connect to it.

Connecting to a PColP Remote Workstation Card through the command line

You can connect directly to a PColP Remote Workstation card from a PColP Software Client by
launching the client from the command line. For details, see hard host in client configuration.

PColP Remote Workstation Card Limitations

Not all features with the Software Client are fully supported when connecting to a PColP Remote
Workstation Card. The following section outlines these limitations against certain features.

Audio: PColP Remote Workstation Card uses a hardware based audio protocol which is not fully
supported on the Software Client.

Topology: Single display configurations will work. There may be disruptions in the forms of black
bars or scroll bars on the client if the PColP Remote Workstation Card does not support the
display configuration on the client.

USB: Connecting USB devices to the PColP Remote Workstation Card is not supported.
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Connecting Remotely using NAT or VPN

Performance: The PColP Remote Workstation Card does not support PColP Ultra enhancements.

Connecting Remotely using NAT or VPN

The same principles that apply for PColP Zero Clients apply to PColP Software Clients when
connecting to multiple hosts through a WAN. Connections from a PColP Software Client to a
Remote Workstation Card across a WAN will require a VPN or NAT setup with enterprise level
NATing devices. For information on how to connect a PColP Software Client to a Remote
Workstation Card installed in a Windows host computer, see Conections from Software Clients in
the PColP Remote Workstation Card Administrators’ Guide.
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Disconnecting a Session

Disconnecting a Session

To disconnect a PColP session:

1. If you are in a full-screen mode, reveal the Software Client for macOS menu bar by moving the

mouse cursor to the top of a display.

2. From the Software Client for macOS menu bar, select Connection > Disconnect.

d Tip: Quickly disconnect from a session

To quickly disconnect from a session, press  Ctrl + ALt + F12 .

Quitting the PColP Client application will also disconnect the current session.
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Display Modes

Display Modes

When you connect to a PColP session, the Software Client for macOS shows your remote desktop
as one or more displays. The number of displays it shows is constrained by your local system's
available monitors (and the PColP protocol itself, which supports up to four monitors).

You can choose whether the Software Client for macOS shows your remote session as a single
display in a resizable window, or as one or many full-screen displays.

You can also add or remove local displays during a session.

You can switch between three display modes as needed during a session. Note that some of these
modes are system-dependent; for example, if your local system has only one monitor, you will not
see options for multiple displays.

+ Windowed mode: A single display shown in a window.

« Full Screen All Monitors: All available local monitors are used in full-screen mode to show the
remote desktop.

+ Full Screen One Monitor: A single display shown full-screen on the local system.

Windowed Mode

In Windowed mode, the Software Client for macOS provides a single window, resizable and
movable, which contains the remote desktop. The remote desktop will rescale to fit your window
dimensions if you change them.

To use windowed mode:

1. Reveal the Software Client for macOS menu bar by moving the mouse cursor to the top of a
display.

2. From the Software Client for macOS menu bar, select View > Leave Fullscreen.
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Full Screen Modes

Full Screen Modes

In full-screen modes, the Software Client for macOS expands to fill either one local display or all of

your local displays.

In both full-screen modes, the Software Client for macOS menu bar is hidden. To reveal it, move
your mouse cursor to the top of the display and hover for a moment.

6 Tip: Quickly switch to full-screen mode

You can quickly switch from windowed mode to whichever full-screen mode you used last by pressing

ctrl + alt + Enter .

6 Important: Enable Displays have separate Spaces

Displays have separate Spaces must be enabled for full-screen behavior to work as expected. See Enable Displays

have separate Spaces.

Enable Displays have separate Spaces

Full-screen modes extend macOS Mission Control functionality. To work as expected, Displays

have separate Spaces in Mission Control settings must be enabled.
To enable Displays have separaet Spaces:

1. Open System Preferences....
2. Click Mission Control in the preferences window.

3. In the Mission Control settings window, find and check the box beside Displays have separate

Spaces.

© 2021 Teradici

48



Full Screen Modes

o0 < itit  Mission Control |[ Q ]]

Mission Control gives you an overview of all your open windows, thumbnails of your full-
screen applications, all arranged in a unified view.

Automatically rearrange Spaces based on most recent use

When switching to an application, switch to a Space with open windows for the application

Keyboard and Mouse Shortcuts

With a single keystroke, view all open windows, windows of the current application, or hide windows to locate an
item on the desktop that might be covered up.

Mission Control: 1 ($] - e
Application windows: ~J 8 = 8
Show Desktop: 8 - 9

(for additional choices press Shift, Control, Option, or Command)

Hot Corners... ?
A 4

If you do not enable Displays have separate Spaces, each remote display may appear on a Space

with black screens on the other displays.
Full Screen All Monitors

In full screen all monitors mode, the application expands to present full-screen remote displays on
all of your local monitors. The remote desktop will map a remote display to each of your local

displays.
You will only see this option if your local system has multiple displays.
To use Full Screen All Monitors mode:

1. If you are in full-screen one monitor mode, reveal the Software Client for macOS menu bar by

moving the mouse cursor to the top of a display.

2. From the Software Client for macOS menu bar, select View > Fullscreen All Monitors.
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Adding or Removing Displays

Full Screen One Monitor

In full screen one monitor mode, the presents a single full-screen remote display on one of your
monitors.

If you switch from Full Screen All Monitors to Full Screen One Monitor, all open windows and
applications will be moved onto the single display.

6 Tip: Monitor selection

The local monitor chosen for full-screen display depends on the mode you are switching from:

- If switching from windowed mode, the client's current display becomes full-screen.

- If switching from full screen all monitors mode, the display used to select fullscreen one monitor mode becomes
full-screen.

- If using the green menu bar button to enable full screen mode, the monitor the window was on will become full-
screen.

To use Full Screen One Monitor mode:

1. If you are in a full-screen mode already, reveal the Software Client for macOS menu bar by
moving the mouse cursor to the top of a display.

2. From the Software Client for macOS menu bar, select View > Fullscreen One Monitor.

/" Note: Systems with only one display

If your local machine has only one display, the menu option will say Show Fullscreen.

Adding or Removing Displays

You can add or remove local displays during a PColP session. If you are using full screen all
monitors mode, you must detect the changes before they will be effective. Note that in the case of
removing monitors, this could mean that some applications or information is inaccessible until the
detect monitors command is issued.
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Detecting Monitors

Detecting Monitors

If the local display configuration changes during a session—for example, if you attach a new local
monitor, or disconnect an old one—the display mapping between the local and remote
topographies is no longer accurate,leading to unpredictable display behavior. You must be refresh
the display mapping to accurately show the new configuration.

To synchronize local display changes:

1. If you are in a full-screen mode already, reveal the Software Client for macOS menu bar by

moving the mouse cursor to the top of a display.

2. From the Software Client for macOS menu bar, select View > Detect Monitors.

The local display configuration will synchronized with the remote. The local displays may flicker or
go black momentarily while the remote system updates its display topography.
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Mission Control in PColP Sessions

Mission Control in PColP Sessions

macOS provides a number of methods for activating Mission Control. Some of these methods are
reserved by the Software Client for macOS to allow local use of Mission Control, and others are
forwarded to the remote desktop, where the remote macOS system can use them.

The following table describes which key combinations and gestures are reserved by the local client
machine and which are sent to the remote host. These are the default invokation methods; if keys

or gestures have been remapped, use the modified equivalent.

All local methods invoke Mission Control on the client Mac, and all remote methods invoke it on

the remote macOS host.

Activation Method Local or Remote

Mission Control

Press Mission Control key on a keyboard with a Mac layout (normally [F3 ) Local
Swipe up with three or four fingers on an Apple Trackpad. Local
Double-tap an Apple Magic Mouse with two fingers Local
Select Local Mission Control from the Software Client for macOS menu bar, Local

orpress (Ctrl+x+M
Press ctrl+ 4 on keyboard Remote

Press %+ Space, type Mission Control and press return/(while in-session) Remote

Mission Control commands and gestures have no effect on Windows or Linux desktops.
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Connecting USB Devices

Remote desktops can use USB devices that are attached to the client, using a process called
redirection. USB devices are not automatically redirected to the remote desktop; they must be
specifically connected to the session.

2" Note: Excludes Mice and Keyboards

Normal Human Interface Devices (HID), such as keyboards and mice, are always connected and used by the remote
desktop. This page describes using non-HID USB devices such as tablets or cameras.

Important considerations

- USB functionality depends on PColP Agent configuration: The remote PColP agent must be
configured to allow USB redirection. If it is not, only HID devices like keyboards and mice will
be used, and the Connection > USB Devices option will not be visible in the Software Client for
macOS menu bar.

+ Local Termination and Bridging: Most USB devices are bridged to the host, which means their
input is sent directly to the host machine for processing. Certain devices, including ePadLink
Signature Pads and some Wacom tablets, connect using a different method called local
termination. This mode does some pre-processing of device information locally at the client
before forwarding to the host, resulting in increased responsiveness and better tolerance of
high-latency networks.

The mode chosen is automatic, unless overridden. See Wacom Tablets for information about
which Wacom tablets are supported.

+ Persistence: USB device connections do not persist across multiple PColP sessions. You
must connect your USB device each time you connect.

+ NoMachine USB Drivers: PColP Clients are not compatible with NoMachine and No Machine
USB drivers. For information on how to uninstall NoMachine USB drivers, see NoMachine's
knowledge base.
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Connect a USB Device

Connect a USB Device

/" One-time PColP Software Client for macOS login

The first time you connect a USB device on a newly-installed Software Client for macOS, you must enter an
administrator's credentials. You only need to do this once on each new client installation.

To Connect a USB device:

1. Attach the USB device you want to connect to your local machine.
2. Select Connection > USB Devices from the PColP Software Client menu.

A list of all USB devices connected to your client machine appears. The list includes both
external devices you plug in and integrated devices such as laptop cameras.

The name shown in the list is self-reported by the device; some devices will identify

themselves only as USB Device.

6 Important: Connecting special HID devices

Because most Human Interface Devices (HIDs) are automatically processed by the Software Client for macOS,
they do not appear on this list even if they use a USB connection. However, certain HID devices—like 3D mice
and Wacom tablets—actually do require processing on the remote host, and will not work as expected unless

connected to the session.

To show these hidden HID devices and allow them to be connected, enable the Show Human Interface Devices
checbox. You may also need to perform additional configuration steps or install drivers on the remote machine.

3. Click Connect beside the USB device you want to use.
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Disconnect a USB Device

® 0 USB Devices

DEVICES
v3.5.0.8 Connect
Bluetooth USB Host Controller Unauthorized

| Show Human Interface Devices. Devices that are auto-forwarded are not affected by this checkbox.

Disconnect a USB Device

1. Select Connection > USB Devices from the PColP Software Client menu.
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Automatically Forward All USB Devices

2. Click Disconnect beside the USB device you want to disconnect.

[ USB Devices X

DEVICES

ADATA USB Flash Drive Disconnect

[] show Human Interface Devices. Devices that are auto-forwarded are not affected by this checkbox.

Automatically Forward All USB Devices

Automatic forwarding allows you to bridge all non-HID USB devices without requiring a manual
connection step.

/" Note: Auto-forwarded devices can be disconnected from the client

Devices that are automatically forwarded can still be disconnected and reconnected via the Software Client for
macOS interface.

To enable automatic USB forwarding in the pre-session interface:

1. Disconnect any active PColP sessions and return to the pre-session interface.

2. Click the gear icon to open the settings window:
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Automatically Forward Devices by Vendor ID/Product ID

3. Click USB Devices in the left side menu, then enable USB auto-forward in the USB Auto-
Forward for Non-HID Devices panel.

USB Devices
Logs USB Auto-Forward for Non-HID Devices
Advanced A HID (Human Interface Device) is a device that enables you to input

data and interact directly with the computer. Examples of these devices
include keyboards, mice, controllers, etc. The USB auto-forward feature
enables you to bridge all non-HID devices to the PColP Client.
Examples of non-HID devices include Wacom Tablets, un-supported
keyboards, etc.

USB auto-forward

To enable automatic USB forwarding programmatically:

To enable automatic forwarding programmatically, launch the client using either the command-line

or URI methods and use the usb-auto-forward flag. For more information, see USB Auto-
Forward in the Configuration section.

Automatically Forward Devices by Vendor ID/Product ID

You can automatically forward specific devices to the remote host without requiring a manual
connection step (devices not specified can still be connected manually, as shown above).

/" Note: Auto-forwarded devices can be disconnected from the client

Devices that are automatically forwarded can still be disconnected and reconnected via the Software Client for
macOS interface.

Devices are identified by their Vendor ID and Product ID (VID and PID, respectively) which together
make a unique identifier. You can specify up to 20 devices to automatically connect using this

© 2021 Teradici

S/



Identifying Vendor and Product IDs

method. If more than 20 devices are provided, only the first 20 will be accepted. The rest will be
ignored, and noted in logs.

Invalid VID/PID pairs are discarded, and noted in logs.

To enable automatic forwarding by Vendor ID and Product ID, launch the client using either the
command-line or URI methods and use the vidpid-auto-forward setting, providing the VID/PID
pairs for the devices you want to connect. For more information, usage, and examples, see Vidpid
Auto-Forward in the Configuration section.

|dentifying Vendor and Product IDs

If you do not know the Vendor ID and Product ID of the device you want to automatically forward,
you can discover them using the client logs.

To discover the Vendor and Product IDs:

1. Unplug all USB devices.

Launch the Software Client for macOS.
Plug in the device.

Close the Software Client for macOS.

Find the most recent PColP Client log file.

S

In a log viewer or text editor, look for lines containing MGMT_USB :Device, and VID=. In this
example, there are two entries with MGMT_USB :Device ; we want the first line, which also
contains the VID and PID assignments:

2040-12-12T20:36:46.117Z eBf9e9e9e-866f-1038-test-ac87a3007abc LVL:2 RC:

0 MGMT_USB :Device 0x00010001 VID=0x18a5PID=0x0302
2040-12-12T20:36:46.117Z eBf9e9e9e-866f-1038-test-ac87a3007abc LVL:2 RC:
0 MGMT_USB :Device 0x00010001 Name=TEST Serial=012345ABCDE

pPp=000222222

7. VID and PID assignments appear like this: VID=0x<VID_VALUE>PID=8x<PID_VALUE> . The VID
and PID values we need are the strings after ox.

Continuing the example, VID=0x18a5PID=06x0302 means the VID we wantis 18a5, and the
PID is 0302 .
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Identifying Vendor and Product IDs

8. The VID/PID pair is expressed as <VID>, <PID> . Following our example, this device would be
specified as 18a5,0302 .

9. Provide this (and others, if applicable) VID/PID pair to Vidpid Auto-Forward when launching via
command line or URI, as indicated above.
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Configuring Wacom Tablets

Configuring Wacom Tablets

This section outlines how to configure your Wacom tablet through the PColP Client session. There

are two available features within the PColP Client that can be used to configure the monitor

display and orientation.

USB Connection Instructions

Before you carry out the Wacom tablet monitor configurations below, you must connect to the device by following the

instructions outlined in the Connecting to USB Devices section.

Wacom Tablet Monitor

The Tablet Monitor feature enables you to select the monitor you want to use with your Wacom

tablet. You can change between using a pen or mouse and select the orientation position.

To configure Tablet Monitor settings:

1.

2
3
4.
5

Select View from the in-session options bar.

. Check the Tablet Monitor option.

. Open Wacom Tablet Properties from the Wacom Desktop Center.

Select your device, tool and application.

. Select your screen area from the dropdown menu.
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Wacom Tablet Monitor

Teradici PColP Client Connection  View

Leave Fullscreen Ctrl+Alt+Enter

] Show Fullscreen One Monitor
Recycle Bin

Tablet Monitor
Tablet Orientation Left-handed

@ Wacom Tablet Properties

Device:

Intuos Pro M

-

Functions

Application: .
All

Minimize Client Ctrl+Alt+M

/

Pro Pen 2

Pen Eraser Mapping

Use Windows Ink

Orientation: ExpressKeys Left
Mode

(® Pen

Screen Area: Monitor 1

Tablet Area: Full

(O Mouse

Full
Portion...

Monitor 2

Default
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Tablet Orientation Left-handed

Tablet Orientation Left-handed

The left-handed orientation configures the tablet for a left-handed orientation. Select ExpressKeys
Right for a left-handed orientation, and ExpressKeys Left for a right-handed orientation. Rotate the
tablet to the desired orientation.

To configure Tablet Orientation:

1. Select View from the in-session options bar.
Check the Tablet Orientation Left-handed option.
Open Wacom Tablet Properties from the Wacom Desktop Center.

Select your device, tool and application.

a > w0

Select your orientation from the dropdown menu.
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Tablet Orientation Left-handed

Teradici PColP Client Connection  View

Leave Fullscreen Ctrl+Alt+Enter

] Show Fullscreen One Monitor
Recycle Bin

Tablet Monitor
v Tablet Orientation Left-handed

@ Wacom Tablet Properties

Device:

Intuos Pro M

Minimize Client Ctrl+Alt+M

-

Functions

/

Pro Pen 2

Application:

All

Pen Eraser Mapping

Use Windows Ink

Orientation: ExpressKeys Right

Mode

(® Pen

ExpressKeys Left
Ex

ExpressKeys Bottom

Screen Area: Monitor 1

[] Force Proportions

Tablet Area: Full

Default

Options...
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Reset Virtual Desktop

The following section outlines how to reset a saved desktop in the PColP Client. You can reset to a
virtual desktop by following the steps outlined below:

1. Click the configure button and select Edit from the popup menu. Alt Text

2. Click NEXT on the initial saved connection screen. Alt Text
3. Enter your access credentials and click SAVE. Alt Text
4

. Click the configure button and select Reset. If the Reset option is not available, then this
feature is not supported by the Connection Manager. Alt Text
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Enhanced Audio and Video Synchronization

Enhanced Audio and Video Synchronization

Enhanced Audio and Video Synchronization provides improved full-screen video playback,
reducing the difference in delays between the audio and video channels and smoothing frame
playback on the client. This improves lip sync and reduces video frame drops for video playback.

This feature introduces a small lag in user interaction responsiveness when enabled. Using
enhanced audio and video synchronization will reduce the maximum frame rate.

AV Lock is enabled on a per-display basis, so you can dedicate individual displays to playback
without impacting responsiveness on the others.

To use AV Lock:

1. If you are in full-screen mode, reveal the menu bar on the display you want to enhance by

moving the mouse cursor to the top of the screen.

2. On the display you want to enhance select View > AV Lock to toggle the enhanced sync mode.

ﬂ Persistent Display Topology

The Enhanced Audio and Video Synchronization feature is persistent across sessions from the same client, provided

that the display topology has not changed.

PColP Ultra AV-Lock

PColP Ultra AV-Lock enables regulated synchronization of audio and video frames. When audio is
playing the video frames will be delayed to align with the audio sound track. When there is no
audio playing the video frames will be presented to the user without delay. In some use cases,
such as video editorial, audio video synchronization, it must be tolerant of variable network

conditions that may be present with remote work.

PColP Ultra AV-Lock enables more regulated synchronization of audio and video frames compared
to AV Lock that's described above. PColP Ultra AV-Lock is available with PColP Ultra CPU Offload,
GPU Offload or Auto Offload. You must enable the High Performance Client mode for this feature
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PColP Ultra AV-Lock

to function correctly, for instructions on how to activate this High Performance Mode, see PColP
High Performance Client.

To activate Ultra AV-Lock from the High Performance Client menu, under the menu "View - PColP
Ultra AV-Lock", select the monitor you wish to activate Ultra AV-Lock on. Monitors with Ultra AV-
Lock activated will be indicated with a checkmark in the menu. This may be switched on/off for

individual monitors in-session, and will be remembered for future sessions as long as the monitor
topology remains the same.
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Sending a Ctrl-Alt-Del Command

Sending a Ctrl-Alt-Del Command

To send the Ctrl-Alt-Del keyboard command to a remote workstation, select the Connection >
Send CTRL-ALT-DEL menu option.

@ Teradici PColP Client [el st View
O O

Recycle Bin
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Configuring the PColP Software Client for macOS

Configuring the PColP Software Client for macOS

The Software Client for macOS provides a number of configurable settings and behaviors, which
allow the setting of user options, performance modes, and triggering actions like automated
connections. These settings are not persistent and cannot be set via the user interface; they are
set by launching the application using one of the methods described next.

To configure a client instance, you must launch it using one of these methods:

+ On the command line, with configuration values passed inline as flags, or

+ Via a URI, providing your configuration values in an encoded JWT string.

Setting Configuration Values on the Command Line

To set configuration values this way, launch the Software Client for macOS from a command

prompt, and include the required options as flags. Multiple flags can be included in the same line.

Use the following conventions when setting these parameters:

Type Format

Boolean No value is required; the flag implies "True"
Numeric Provide the parameter and then the numeric value, separated by a space.
String Provide the parameter and then the string value, separated by a space.

Values can be wrapped in double quotation marks if they contain spaces.

The following example launches the client in full-screen mode, sets log level 3, and points to a
connection broker at broker.domain.com (if your application is installed somewhere else, use
your own path instead):

/Applications/PCoIPClient.app/Contents/Mac0S/PCoIPClient --connection-broker
broker.domain.com --log-level 3 --full-screen

The available settings are shown below.

© 2021 Teradici

68



Setting Configuration Values via a URI

Setting Configuration Values via a URI

Using this method, the Software Client for macOS is launched using a URI with configuration
options (and, optionally, connection credentials) encoded in a JWT token string.

To use this method, create a URI with the following structure:
pcoip://[broker]/connect[?data={jwt}]

Where each segment shown above is:

Segment Description

pcoip:// Required. This scheme is registered with the operating system and will launch the Software
Client for macOS.

broker Optional. FQDN of the connection broker to use. If the connection is not brokered, this can be
omitted.

/connect Required. Requests a connection with the parameters defined in "?data’

? Optional. The string indicated by {jwt} here is a JWT payload, containing any required

data={jwt} configuration settings and connection credentials. If all you want to do is launch the client with

no options set, this can be omitted.

The JWT payload can contain both credential information and client configuration. To create the
JWT payload:

1. Create your configuration and credentials as a JSON object, using available configuration
parameters and authentication credentials.

2. Encode the object as a JWT token.

3. Pass the token through the URI as the data parameter.

For example, the following JSON object would launch the client in full-screen mode, with log level
3
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Configurable Settings

"fullscreen" :true,
"log-level”:3

Encoded, and pointing to a connection broker at broker.domain.com, this would result in a URI
similar to the following:

pcoip://broker.domain.com/connect?
data=eyJhbGciO0iJIUzITNiIsInR5cCI6IKkpXVCJ9.eydmdWxsc2NyZWVuIjpOcnV1LCJIsb2ctbGV2ZWwiC

The available settings are shown below.

Configurable Settings

The following settings can be configured on the Software Client for macOS.

General Settings
These settings affect the client's behavior both in and out of PColP sessions.
Language

Sets the user interface language.

A\ Caution: Localization is not available in this release

Localization has not been implemented in this version of the user interface, and will always display English text. This
parameter is ignored.

Localization support will be implemented in a future release.

Options Default Type
English only in this release Not set string
Usage
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Connection Settings

Method Valid Full IETS Example
Command Line v --locale - --locale zh_CN
URI v locale loc {loc: "zh_CN"}

Connection Settings

These settings control how the Software Client for macOS connects to PColP sessions.
Connection Broker

The connection broker's URL.

Note that this parameter is used by the command line only; when using the URI method, the
connection broker URL is part of the URI (not part of the configuration JWT payload).

Values Default Type
The URL for the connection broker, if present - string
Usage
Method Valid Full Alias Example
Command Line v --connection-broker -b -b broker.domain.com
URI - - - —
Desktop

The name of the desktop to connect to.

Values Default Type

The name of a desktop to conect to - string
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Connection Settings

Usage
Method Valid Full Alias Example
Command Line v --desktop - --desktop myDesktop
URI v desktop vm {vm: "myDesktop"}
Domain

The domain to send to the connection broker.

Options Default Type

The name of the domain to provide to the connection broker. - string
Usage

Method Valid Full Alias Example

Command Line v --domain -d --domain domain.example.com

URI v domain dom {dom: "domain.example.com"}
Hard Host

If connecting to a PColP Remote Workstation Card (also known as a hard host), provide its URL
using this parameter.

This option is ignored if the connection-broker urlis provided.

Options Default Type
The URL for the Remote Workstation Card. - string
Usage
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Connection Settings

Method Valid Full Alias Example
Command Line v --hard-host -h -h rwc.example.com
URI - - - -

Password

The password sent to the Connection Broker, for logging into a desktop. Transmitting passwords
this way is not recommended.

/" Note: Command-line only

Passwords can only be sent via the command line. You cannot send a password in a JWT payload.

Options Default Type

A string password. Not set string

Usage
Method Valid Full Alias Example

Command Line v --password -p -p mypassword

URI — — — —

Security Mode

The security mode used for validating connections.

/" Note: This setting can be provided in the user interface

This setting is available from the user interface, in addition to the methods described here. For details, see PColP
Software Client Security Modes.
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Connection Settings

Options Default Type

@ : Verification not required 1:Warn, but allow integer
1: Warn, but allow

2 : Full verification required

Usage
Method Valid Full IETS Example
Command Line v --security-mode -s -s 2
URI v security-mode sec {sec:2}
Session ID

This setting launches the JSESSIONID. This parameter is only available via JWT; it cannot be used
on the command line.

Options Default Type
The session ID to launch. Not set boolean
Usage
Method Valid Full Alias Example

Command Line - - - -

URI v sessionid sid {sid: exampleSessionID}

Username

The username sent to the Connection Broker.
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USB Settings

Options Default Type

The username to pass to the connection broker Not set string
Usage

Method Valid Full IETS Example

Command Line v --username -u -u myUsername

URI v username usr {usr: "myUsername"}
USB Settings

These settings control how USB devices connect to PColP sessions, including rules for which
devices are allowed to be forwarded.

Disable USB

USB devices are available by default. Use this flag to disable USB connections. This will not
prevent simple human input devices like mice or keyboards from connecting.

Options Default Type

true : disabled false (USB enabled) boolean
false : enabled

Usage
Method Valid Full Alias Example
Command Line v --disable-usb — --disable-usb
URI v disable-usb nousb {nousb: true}
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USB Settings

USB Auto-Forward

This setting auto-forwards all non-HID devices to the host.

Options Default Type

True : Auto-forward USB devices False (do not auto-forward) boolean
False : Do not auto-forward USB devices

Usage
Method Valid Full Alias Example
Command Line v --usb-auto-forward - --usb-auto-forward
URI v usb-auto-forward uaf {uaf: true}

/" Note: This setting is available in the user interface

This setting is also available in the client's pre-session user interface, by clicking the gear icon and selecting USB
Devices.

Vidpid Auto-Forward

To auto-forward specific devices, provide their VID and PID values separated by a comma (
Multiple values can be provided, separated by spaces. Enclose the list in quotation marks.

Options Default Type
The list of VID,PID values to auto-forward Not set string
Usage
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Session Behavior Settings

Method Valid Full Alias Example

Command v --vidpid-auto- - --vidpid-auto-forward "aal1,bb22
Line forward cc33,dd44"

URI v vidpid-auto-forward vaf {vaf: "aal1,bb22 cc33,dd44"}

If you are not sure of the device's ID values, see Identifying Vendor and Product IDs for
instructions.

Vidpid Black List

To block specific devices from auto-forwarding at all, provide their VID,PID values as a space-
separated list using this parameter.

This setting overrides usb-auto-forward and the USB dialog in the client interface.

Options Default Type

The list of VID,PID values to block Not set string

Usage
Method Valid Full Alias Example
Command v --vidpid-black- - --vidpid-black-list "aal1,bb22
Line list cc33,dd44"
URI v vidpid-black-1list vbl {vbl: "aal1,bb22 cc33,dd44"}

If you are not sure of the device's ID values, see Identifying Vendor and Product IDs for
instructions.

Session Behavior Settings

These settings control the client's behavior once a session is connected.
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Session Behavior Settings

Fullscreen Mode

Fullscreen mode enables the display topology to support multiple monitors as an extended
desktop.

If both fullscreen and windowed parameters are sent, the client will launch in Windowed mode.

Options Default Type

true : full screen Not set (uses client's last-set mode) boolean
false : windowed

Usage
Method Valid Full Alias Example
Command Line v --fullscreen -f -f
URI v fullscreen full {full: true}
Windowed Mode

Launches the client in windowed mode.

If both fullscreen and windowed parameters are sent, the client will launch in Windowed mode.

Options Default Type

True : Launch in windowed mode False (does not request windowed mode) boolean
False : Do not request windowed mode

Usage

Method Valid Full Alias Example

Command Line v --windowed -w -w

© 2021 Teradici 78



Log Settings

Method Valid Full Alias Example
URI v windowed win {win: true}
Log Settings

These settings control logging functionality, including verbosity and file location.
Log Folder
A custom location for client log files.

Options Default Type

A valid system path to a folder Not set string

Usage

Method Valid Full Alias Example
Command Line v --log-folder — --log-folder path/to/folder

URI — — — —

Log ID

A unique ID that will identify sessions in all PColP log files (including those created by other
components like agents and a connection manager).

Options Default Type
A unigue session identifier Not set string
Usage

© 2021 Teradici

79



Log Settings

Method Valid Full IETS Example
Command Line v --log-id - --log-id abcde1234
URI - = - -

Log Level

Sets the log level. This parameter will override any existing configuration values.

Options Default Type
0 : Critical Not set integer
1: Error
2 :Info
3 : Debug
4 :Verbose
Usage
Method Valid Full Alias Example
Command Line v --log-level -1 -12
URI v log-level logl {logl:2}

/" Note: This setting is available in the user interface

This setting is also available in the client's pre-session user interface, by clicking the gear icon and selecting Logs.

Log Prefix

A user-defined prefix for log files. This value will be prepended to the timestamp in the log file
name, like this:

<log-prefix value><timestamp>

Log files are saved in the location provided by log-folder .
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Advanced Settings

Options Default Type
A prefix to use in generated log file names Not set string
Usage
Method Valid Full Alias Example
Command Line v --log-prefix - --log-prefix example-prefix
URI - - - -

Advanced Settings

A\ Caution: General use of these settings is not recommended

These settings are intended for specific use cases, and can drastically alter the behavior of the Software Client for
macOS. Unless you understand what these settings do, and have a clear need to use them, they should be avoided.

Disable Hotkeys

Session convenience hot keys, such as (Ctrl + Delete + F12 (which disconnects a PColP
session) are available to users by default. Use this flag to disable all hotkeys.

Options Default Type

true : disabled false (hotkeys enabled) boolean
false : enabled

Usage
Method Valid Full Alias Example
Command Line v --disable-hotkeys — --disable-hotkeys
URI v disable-hotkeys nohot {nohot: true}
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Advanced Settings

Disable Menu Bar

The PColP client menu bar is available to users by default. Use this flag to disable the menu bar,
preventing users from accessing it or executing any of its functionality.

Options Default Type

true : disabled false (menu bar enabled) boolean

false : enabled

Usage
Method Valid Full Example
Command Line v --disable-menubar - --disable-menubar
URI v disable-menubar nomenu {nomenu: true}
Enable Scaling

This setting enables scaling on the PColP Client without having to specify the desktop resolution.
This can only be configured on a single display. This is off by default.

Options Default Type

true : scaling enabled false (scaling disabled) boolean
false : scaling disabled

Usage
Method Valid Full Alias Example
Command Line v --enable-scaling — --enable-scaling
URI v enable-scaling scale {scale: true}
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Advanced Settings

Force Native Resolution

This setting sets the resolution of the Client monitor to the native resolution when the session
client is launched. This can only be configured on a single display.

2" Note: Windows client only

This parameter is only available on Windows clients. It will have no effect if provided to a Linux or macOS client.

Options Default Type

true : force enabled false (Resolution force disabled) boolean
false : force disabled

Usage
Method Valid Full Alias Example
Command Line v --force-native-resolution - --force-native-resolution
URI v force-native-resolution native {native: true}

Maintain Aspect Ratio

This setting maintains the display aspect ratio between the host and the Client. Maintaining the
aspect ratio in this way can result in letterboxing if the two devices are naturally different.

This can only be configured on a single display.

Options Default Type

true : Maintain aspect ratio False (does not maintain aspect ratio) boolean
false : Do not maintain aspect ratio

Usage
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Advanced Settings

Method Valid Full Alias Example
Command Line v --maintan-aspect-ratio - --maintain-aspect-ratio
URI v maintain-aspect-ratio aspect {aspect: true}

Quit After Disconnect

If this is enabled, disconnecting from the PColP session will immediately quit the {! ./_common/
name.md! }. The pre-session interface will not be available after disconnecting.

Options Default Type

True : Quit on disconnect False (does not quit on disconnect) string

False : Do not quit, show pre-session Ul on disconnect

Usage
Method Valid Full Alias Example
Command Line v --quit-after-disconnect — --quit-after-disconnect
URI v quit-after-disconnect qad {gad: true}

Set Host Resolution
This setting locks the resolution of your host application display.

Provide the value as a string, made up of the horizontal resolution, the letter "x", and the vertical
resolution. For example, "1024x768".

This can only be configured on a single display.

Options Default Type
A fixed resolution the host must use. Not set string
Usage
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Method

Command Line

URI
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v

Advanced Settings

Full

--set-host-resolution

set-host-resolution

Alias

res

Example

--set-host-resolution 1024x768

{res: "1024x768"}
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Preventing Devices From Using Local Termination

Preventing Devices From Using Local Termination

By default, supported Wacom devices use local termination automatically to provide improved
responsiveness and tolerance of high-latency networks. Local Termination does not support all
advanced Wacom features; if you depend on one of these unsupported features, you can fall back
to bridged mode by adding your device to a blacklist. This will pass all tablet data to the remote
host for processing, which will make the full suite of functionality available at the cost of
decreased performance and sensitivity to latency.

To add a device to the local termination blacklist, add the localtermination_black_list setting
and the VID/PID pairs for the devices you want to limit (separate multiple VID/PID pairs with
spaces):

defaults write "com.teradici.Teradici PCoIP Client" localtermination_black_list
"<vid1>, <pid1> <vid2>,<pid2> ..."

..where <vid1>,<pid1> <vid2>,<pid2> represent VID/PID pairs of devices to be put on the local
termination blacklist.

If you do not know the Vendor ID and Product ID for the device you want to blacklist, use the
method shown in Identifying Vendor and Product IDs.

Troubleshooting HID Local Termination Blacklist

There is no user-facing indication of which mode a device is using to connect. If you are
troubleshooting a connection and need to understand which mode is being used, inspect the
PColP agent logs for a session. If the device is using local termination, you will see lines similar to
these:

pcoip server log: 'LVL:2 RC: © MGMT_KMP :Client added HoIP device (id:0x000a0085)
with vendor id=0x@56a, product id=0x0391"

pcoip client log: 'LVL:2 RC: © MGMT_USB :HoIP supported device detected (Vid:
0x056a, Pid: 0x0391), using HoIP protocol for local termination'
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PColP Software Client Security Modes

The PColP Software Client uses certificates to verify the identity of the host to which it connects.
The security mode is configured by the security_mode setting in the Teradici PColP Client
configuration file or by setting its value in the pre-session user interface.

Three security mode options are available:

Setting Description

value

High 2 Full verification is required; users cannot connect unless a certificate can be verified.

Medium 1 Warn but allow (default). If the certificate cannot be verified, warn the user, but allow
them to connect.

Low 0 Always allow; verification is not required.

/" PColP sessions are always encrypted

Your PColP session is still encrypted and secure if you connect with security mode 0 or 1. The red padlock icon
indicates that the certificate presented by the host is not signed by a trusted certificate authority in the client’s
certificate store, not that the session is insecure.

Setting the Security Mode

To set the security mode using the pre-session interface:

1. Disconnect any active PColP sessions and return to the pre-session interface.

2. Click the gear icon to open the settings window:

3. Click Advanced in the left side menu, and find Security Modes in the right panel.

4. Select the desired security mode.
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Setting the Security Mode

USB Devices

Advanced
Logs
Advanced Security modes

The Anyware Client uses certificates to verify that the server connection is
secure. You can select the security mode that best suits your needs.

Security mode - High
Full verification is required. You cannot connect unless the certificate
has been verified.

Security mode - Medium
If a certificate cannot be verified you will receive a warning, but you will
still be able to connect. This is the default security mode.

(O Security mode - Low
You do not need to verify the certificate to connect.

To set the security mode programmatically:

1. Close the Software Client for macOS.

2. Open a terminal window and type the following command at the command line:

sudo defaults write "com.teradici.Teradici PCoIP Client" security_mode
<value>

..where <value> is your desired security option (0, 1, or 2).

/" Restart May Be Required

You may be required to restart your machine for this change to take effect.
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Installing the Internal Root CA Certificate in a PColP
Client

Your root CA certificate must be installed in any PColP client that will be used to connect to the
PColP Agent.

Installing Root CA Certificates in the PColP Software Client for macOS

6 Important: Root CA Certificate must have a .crt extension

You must change the root CA certificate's extension from . pemto . crt before installing it on a PColP Software
Client.

In macOS, certificates are stored in the Keychain Access application.

To import your root CA certificate in the PColP Software Client for macOS:

1.

N o o > W

Copy your root CA certificate file (*.crt) to the Mac client desktop.

Double-click Applications > Utilities Keychain Access.app to open Keychain Access.
Select File > Import Items.

Navigate to the desktop and then select your root CA certificate.

In the Destination Keychain drop-down menu, select System, and then click Open.

If prompted, enter your Keychain Access password and then click Modify Keychain.

At the next screen, click Always Trust when asked whether you want your computer to trust
certificates signed by this certificate.

If prompted, enter your Keychain Access password and then click Update Settings.

After the certificate installs successfully, it appears in the System > Certificates list.
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Setting Configuration Values via Config files

Certain advanced configuration values are set via configuration files, rather than via the user
interface, command line, or URI methods. These files are read and implemented by the Software
Client for macOS when it launches.

Configuration files can be saved in a system-scoped location, for settings that should apply to any
PColP client launched on a device, or a user-scoped location, for settings that should apply to
specific users. If a setting is found at both levels, the system scope takes precedence.

Configuration files do not exist until a user changes a persistent setting via the user interface. If
that has not ocurred, you must create the file, either manually or using a deployment script.

Setting Config Values

Configuration values are set via plist settings. Each setting is specified by a write command:

User-scope setting:
defaults write "com.teradici.Teradici PCoIP Client" <Key> <value>
System-scope setting:

sudo defaults write "/Library/Preferences/com.teradici.Teradici PCoIP
Client.plist" <Key> <value>

For example, the following file would add the USB device identified by the VID/PID pair 18a5, 08302
to the local termination blacklist, causing it to revert to bridged connections:

defaults write "com.teradici.Teradici PCoIP Client" localtermination_black_list
"18a5,0302"
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Config File Locations

Depending on the desired scope, write settings to the plist file in one (or both) of these

locations. Remember that the system-scoped file takes precedence over the user-scoped file:

Scope Location

System /Library/Preferences/com.teradici.Teradici PCoIP Client.plist

User ~/Library/Preferences/com.teradici.Teradici PCoIP Client.plist
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Enabling Accessibility Permissions for the PColP
Client

The Software Client for macOS must be granted the Accessibility permission in order to properly
handle and transmit local keyboard actions. If the Software Client for macOS is not authorized, the

keyboard will not function in a PColP session.

When the PColP Client is launched for the first time, you are prompted to authorize the
Accessibility permission. This prompt only appears once. If authorization is declined, the

Accessibility permission must be granted manually from System Preferences.

To manually grant accessibility to the Software Client for macOS:

1.

2
3
4.
5

Open System Preferences.

. Click on Security & Privacy.

. Select the Privacy tab.

Select the Accessibility option.

. Click the Lock icon on the bottom left corner and authenticate using your password or touch

ID.

Click the check mark beside PColP Client as shown next:
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Enabling Accessibility Permissions for the PColP Client

{ > i Security & Privacy Q search

General

Photos

Camera

Microphone

Speech Recognition

Accessibility

Input Monitoring

Full Disk Access

Files and Folders

Screen Recording

Click the lock to make changes.
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Mapping Function Keys

Mapping Function Keys

You can enable Function keys on the PColP Software Client for macOS by going to Apple>System
Preferences>Keyboard and selecting the function keys you wish to use as standard keys. When
the system is configured to not use function keys the PColP Software Client does not get the
function key codes from the system when the keys are pressed. In this instance the function keys
are usd for other system features such as turning the volume up and down.
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Capturing Keyboard Keys

The PColP Software Client for macOS captures all keys and redirects them to the remote machine

with the following exceptions:

+ PColP Client short cuts appearing under the Connection and View menus.
- Function Keys (F1 to F12) when in system mode.

+ The Eject and Power keys.

When the PColP Sessions starts, and the PColP Client is the focused foreground application, all
keys, apart from from those outlined above, will be redirected to the remote machine.

Key Combinations Access Permissions
you must grant accessibility in order for the PColP Client to be able to forward all possible keyboard combinations to

the remote workstation. This permission can be enabled in the Security and Privacy tab on the macOS, as outlined in

the screenshot below.
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Security & Privacy Q_ Search

General

FileVault Firewall

Location Services

‘ Contacts

Allow the apps below to control your computer.

ﬁo PColPClient.app

W Microphone +—_
W Speech Recognition
@ Accessibility
) J
Click the lock to prevent further changes. Advanced...
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Support and Troubleshooting

If you encounter a problem installing or using the Software Client for macQOS, there are a number
of troubleshooting and support resources you can access.

- We maintain an extensive knowledge base which answers many questions and documents
solutions to common problems. The knowledge base is part of the Knowledge Center; click on
the Articles tab to access it, or enter a search query in the search field at the top of the page.

+ We host a community forum, allowing you to ask questions and get answers from other IT
professionals and our support team, which monitors this channel. The forum is part of the
Knowledge Center; click on the Discussions tab to access it.

« If you need more help, open a support ticket and our support team will engage with you
directly.

Creating a Support Bundle

Our support team may request a support bundle from you. The support file is an archive
containing logs, diganostic data, and system information that helps the team diagnose problems.

To create a support file:
1. Open a terminal window.

2. Launch the support bundler:

sudo /Applications/PCoIPClient.app/Contents/Resources/pcoip-client-support-
bundler

The support bundler will collect diagnostic information and logs, and bundle them into a .tar.gz

archive in the user's home directory. Support bundle files look like this: supportbundle-
client-2021-04-21T212121127.tar.gz.
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Finding Your Client Version

Finding Your Client Version

You can find your Software Client for macQOS version number from the pre-session interface, or, if
you're already in a session, from the client menu bar.
+ Pre-session: If you are not in a session:

o Click on the hamburger icon, found at the bottom left of the screen beside the Cancel
button.

Alt Text
o From the context menu that appears, select About.
o Find the version number in the information window that appears.
+ In-session: If you are in a session:
o Find or reveal the client menu bar
o Select Anyware PColP Client > About Anyware PColP Client.

o Find the version number in the information window that appears.

"8 Teradici PCoID Cliant el o I
About Teradici PColP Client

Services >

Hide Teradici PColP Client 3H
Hide Others X #H
Show All

Quit Teradici PColP Client  38Q
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Client Logs

The Software Client for macOS writes log files that document its processes and interactions with
other services such as brokers and agents. These files are invaluale in diagnosing problems. This
page describes how logs are handled and where they can be found.

Log Location

Software Client for macOS log files are located within the user's Home Library folder, which is
hidden by default. The recommended way to access Home Library files is to use the macOS
Console.

You can also display log files in a macOS terminal window.
To display log files using the macOS Console:

1. To open the Console, go to the Applications > Utilities folder, and then double-click Console.

2. In the FILES section of the Log List pane on the left, navigate to the following folder: ~/
Library/Logs/Teradici/PCoIPClient

3. Select the desired log file to view its contents in the main pane.
4. To copy the contents:

+ Click anywhere in the log contents, and then select Edit > Select All.
+ Select Edit > Copy.

+ Paste the contents into an email or text file.
To display log files in a macOS terminal window:

1. To open a terminal window, go to the Applications > Utilities folder, and then double-click

Terminal.

2. Navigate to the PColP Software Client log folder by typing the following command at the
command line prompt:

cd ~/Library/Logs/Teradici/PCoIPClient
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Log Levels

3. Type 1s todisplay the list of log files.

4. To view the contents of a log file, use any macOS command-line editor to open it.

Log Levels

Log verbosity is defined by a level, respresented by an integer from 0 to 3:

Level Description

8 Critical messages only

1 Error messages and higher

2 Info messages and higher (default)
3 Debug messages and higher

The default setting is 2, recording informational messages and higher.
The log level can be changed in any of the following ways:
To set the log level in the pre-session interface:

1. Disconnect any active PColP sessions and return to the pre-session interface.

2. Click the gear icon to open the settings window:

3. Click Logs in the left side menu, and specify the desired log level in the panel.
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Log Levels

USB Devices

Logs

Advanced

Logs

You can set log levels to determine the level of details provided in the
log. Log levels range from Level 0 (Critical) to Level 3 (Debug), where

Level 0 provides the least information and Level 3 provides the most
information.

Log level

Level 3 - Debug v

To access the log files, click the “Show in folder" button.

B Show in folder

To set the log level programmatically:

This method provides the log level inline during a command line launch; see Log Level in the

configuration section for details.

effective.
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6 Tip: Reporting issues to support

When you are reporting an issue to support, set the log level to 3 (debug) first, and then reproduce the issue and
create a support bundle. This will capture much more detail than the default setting, making diagnostics more
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